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1 INTRODUCTION 
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1.1 ABOUT 

ArCADia-POWER NETWORKS  is an intelligent tool that expands ArCADia-INTELLICAD/AutoCAD with 

features necessary to create professional documentation concerning the design of external LV power networks. 

The software is addressed both to designers  of networks, installations of electric and power networks, as well as 

to anyone associated with the electro-technical industry. The user of the ArCADia-POWER NETWORKS 

software is able to quickly create drawings of external power networks on spatial development plans or to make 

their own drawing showing the network between the LV transformer and switchboard in the building. The user 

may also use a library of items employed when designing, along with an option to edit the items and add parameters 

to them. Apart from the efficient creation of technical drawings, the software carries out calculations necessary to 

design the network correctly and create professional technical documentation. Merging specialized features used 

in the application for creating technical drawings of external power networks along with carrying out the 

calculations and running validity checks on the designed network provides the perfect tool for designing LV 

networks. 

1.2 FEATURES AND FUNCTIONALITIES OF THE PROGRAM 

The technical scope of functionalities provided by the software and its basic functions: 

 
 Designing power cable and overhead connectors for buildings. 

 Designing extensive cable and overhead lines 

 Designing external lighting installation networks 

 Execution of technical calculations 

 Selection of buried and overhead lines 

 Selection of power protection measures 

 Inspection of electric shock protection via quick automatic power cut-off 

 Generating of network verification report reports and material lists 

 

All calculations and the verification carried out by ArCADia-POWER NETWORKS were developed based on 

the following standards and regulations: 

 

[1] PN-87/E-90050. General-purpose power conductors to be placed permanently. General requirements and 

tests. 

[2] SEP N SEP-E-004 standard “Power and signal cable lines – Designing and construction” 

[3] PN-91/E-05009/482 – Protection against electric shock. 

[4] PN-EN 60865-1:2002 (U) Calculation of short-circuit currents effects. Part 1: Definitions and calculation 

methods 

[5] PN-EN 60909-0:2002 (U) Short-circuit currents in three-phase AC networks. Part 0: Calculations of 

currents. 

[6] PN-EN 60269-1:2001 (U) LV safety thermal fuses. General requirements 

[7] PN-EN 60947-3:2002 (U) LV distribution and control devices. Part 3: Load switches, disconnecting 

switches, switch disconnectors and sets of connectors with safety thermal fuses. 

[8] “Album linii napowietrznych wielotorowych niskiego napięcia z przewodami izolowanymi samonośnymi 

o przekroju 25-120 mm2”, Poznań, June 1999. 

[9] PN-IEC 60364-5-523 "Electric installations in buildings. Selection and installation of electric equipment. 

Continuous current-carrying capacity of conductors". 

[10] PN-IEC 60364-4-41 "Electric installations in buildings. Protection for safety. Protection against electric 

shock". 
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Hardware requirements: 

 Procesor Intel Core 2 Duo lub AMD Athlon II (recommended min. Intel Core i5-6500) 

 3 GB RAM (recommended min. 12 GB and system 64-bit) 

 5 GB of free HDD space (recommended SSD) 

 For standard 3D view  graphics card compatible with DirectX 9.0c 1GB RAM,  

for advanced 3D view graphics card compatible with DirectX 11 and min. 3GB RAM 

 Windows 10 , Windows 8.1 , Windows 7 SP1 (recommended Windows 10 64-bit) 

 

2.1 INSTALLING 

The program installation is started automatically when the CD is inserted into the CD drive. The installation should 

be started manually if the Autostart function is disabled. Open the CD content (Computer/CD drive) and run the 

Setup.exe file from the program folder. Once the installation is started, proceed according to instructions displayed 

on the screen. 

2.2 RUNNING 

The software may be started by double-clicking on the CAD program icon located on the desktop and then 

selecting one of the icons in the ArCADia-POWER NETWORKS toolbar. 

2.3 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 

 A standard DWG drawing file.  

 Any of the following sample drawings supplied with the ArCADia-INTELLICAD software may be used.  

 A DXF drawing exchange file.  

 A DWG network transmission file.  

 A DWT drawing template file.  

 

In order to quickly access the last edited drawing choose File> <file name>. The software stores the names of the 

last four drawings. In order to quickly access a drawing from the Open drawing dialogue box, double-click the 

drawing name. 

A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. All you need 

to do to open the drawing in IntelliCAD is to double-click the file. Miniature drawings displayed when browsing 

facilitate the identification of the selected drawing. 

 

Opening an existing drawing 

1. Use one of the following methods: 

o Choose File>Open. 

o On the Standard toolbar select the Open ( ) tool. 

o Write open and then press Enter.  

2. Choose the type of the file you want to open from file type.  

3. Choose the folder that contains the selected drawing.  

4. Do one of the following:  

o Choose the drawing that you want to open and click Open.  

o Double-click the drawing you want to open.  

If the drawing requires a password, provide the password, then click OK to verify the password and click Open 

again. 
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2.4 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing use one of the following methods: 

 On the Standard toolbar click Save. 

 Choose File>Save. 

 Write save and then press Enter. 

 Write qsave and then press Enter. 

 

When you save a particular drawing for the first time, the system will display a dialogue box Save drawing as, 

which enables you to select the folder and provide the name for the drawing. You can use any name at all when 

saving the drawing for the first time. In order to save the same drawing under a different name later, select 

File>Save as and then type in the new name. 

2.5 AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or another system error, it is necessary to save your drawing 

files often. The software may be configured to periodically save your drawings automatically. The Autosave setting 

determines the interval in minutes between automatic saves. The software resets this interval each time when the 

user saves a drawing file. 

 

When the Autosave feature is activated, the software creates copies of the drawing. This file is automatically saved 

to the folder provide under Options>Paths/Files>Temporary file and given the extension indicated in the Drawing 

autosave file extension (SV$ by default). 

 

Configuring ArCADia-IntelliCAD to automatically save drawings 

1. Do one of the following: 

o Select Tools>Options. 

o Write config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to enable the Autosave feature and select the 

autosave frequency. 

4. Click OK. 
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3 WORKING WITH THE SOFTWARE 
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3.1 BASIC SOFTWARE INFORMATION 

ArCADia-POWER NETWORKS enables designing both cable and overhead power networks. The route is to 

be drawn in the metre scale (1 unit on the ArCADia-INTELLICAD screen corresponds to 1 metre in the design). 

The course of action for designing networks is as follows: 

1. You can start drawing the network by designing the power source or defining the connection point. The 

user can also place poles, connectors or a distribution board and then insert the power source. Technical 

calculations will not be carried out if the designed network does not contain the power source and a 

branching element (connector or distribution board). 

2. If we are building a LV network along with a transformer station, we should use the transformer as the 

power source in the drawing. If we are planning an expansion of an existing network, we should define 

properties of the connection point (information about the existing network). The next step is the location 

of distribution and branching points, i.e. cable connectors, electric poles and distribution boards. 

3. When designing an external lighting network (road lighting, local terrain lighting) the user should 

determine the location of the take-off points, such as distribution boards (when designing connections) or 

lighting poles.  

4. Once the power supply and distribution facilities are in place, we can begin designing the network. 

Depending on the area development, we can choose between a buried and an overhead line. 

5. Using the buried or overhead line, we connect to the power source (mouse-click on the transformer) and 

continue with the line, routing it towards a branching or terminal element. This procedure can be carried 

out in the reverse order.  

6. Once the network has been designed, a network structural diagram can be generated. 

7. Once the network has been designed, a report can be generated, showing the results of technical 

calculations along with a validity verification for the designed network. 

8. The user can also generate a list of materials necessary to erect the designed network. 

3.2 SOFTWARE ELEMENT DESCRIPTION 

The ArCADia-POWER NETWORKS adds its own tools to the ArCADia-INTELLICAD/AutoCAD menu, as 

described in the tables below: 

 
 

 

Drawing 1. ArCADia-POWER NETWORKS toolbar 

*BIM – options available to ArCADia BIM license holders, i.e. after purchasing one of the following 

programs: ArCADia, ArCADia AC, ArCADia LT or ArCADia PLUS. 

 

Functions of the ArCADia-POWER NETWORKS toolbar: 

Icon Function Description *BIM 

 
Show/Hide Project 

Manager 
Displays or hides the level management window. √ 

 Insert transformer station Inserts a transformer station along with a description. Χ 

 Insert connection point Inserts a connection point along with a description. Χ 

 Insert distribution board Inserts a distribution board along with a description. Χ 
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 Insert cable joint Inserts a cable joint along with a description. Χ 

 Insert cable joint box Inserts a cable joint box along with a description Χ 

 Insert buried line Inserts a buried line along with a description. Χ 

 Insert overhead line Inserts an overhead line along with a description. Χ 

 Insert power pole Inserts a power pole along with a description Χ 

 Insert protective pipe Inserts a protective pipe along with a description. Χ 

 Insert survey point Inserts survey points on a projection along with a description Χ 

 
Insert schematic diagram Generates a schematic diagram of the designed network Χ 

 Generate report 
Generates a report presenting technical calculations and the 

validity of the designed network. Χ 

 Generate material list Generates a list of materials used in the design. Χ 

 
Insert material list for 

selected elements 

Inserts material list from the installation elements selected on 

the projection. Χ 

 Insert item list 
Inserts an item list of the sewage installation along with the 

graphical symbols, names, markings and quantity. Χ 

 Insert selected elements list Inserts a list of installation elements selected on the projection. Χ 

 
Insert a list of coordinates 

for survey points 

Generates a report containing the X, Y survey coordinates in a 

RTF file. Χ 

 Program option settings Enables the use of standard options for the entire project. Χ 

 Show help Displays the help window. Χ 

 

Once an item is clicked, the following toolbar is shown on the model: 

 

 
 

description painter 

   - type painter 

   - fonts pens painter 

   - set description on the link 

   - edit description  

   -  generate report to file 

   - item coordinate report 

   - object renumbering 

   - move with connections 
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3.2.1 General software options 

The user will also have the possibility to display an options window from the ArCADia menu. An action bar will 

extend, where the user needs to select Options. The general options window of ArCADia software will be 

displayed and then the user should click ArCADia-ELECTRICAL NETWORKS. 

 

 

 

Drawing 2. ArCADia BIM system options window 

 

On the left side of the options window one of the last buttons is the inserting options button. After clicking the 

button the user may open the Options for inserting elements window: 

 

 

Drawing 3. Tracking options window 
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On the left side the user may define how precisely (maximum distance from the element axis which will allow for 

detection) will the elements, axes and angles be detected while element axis  and angles  tracking is enabled 

and elements detection  is enabled. 

Angles tracked may be inserted on the right side of the window. In the table the user may add, using the  

button, another angle which they want to track when inserting elements. If the user wants to delete one of the 

angles, he needs to select it by clicking it in the table and then delete one of the values using the  button on the 

right.  

 

After defining the modification precision and the number and values of the angles tracked, the user may confirm 

the changes using the OK button (changes will be saved in the software) or reject them using the Cancel button 

(all changes done at the time in the tracking options window will be cancelled). 

3.3 CALCULATIONS 

Once the network has been designed and appropriate parameters have been assigned to it, ArCADia-POWER 

NETWORKS will carry out standard calculations: 

 

 maximum and minimum short-circuit currents (single-phase and three-phase short-circuit currents, 

surge current) on individual sections of the designed network, 

 calculation of load currents (1-phase or 3-phase) on individual sections of the designed network, 

 calculation of voltage drops, 

 calculation of short-circuit loop impedance, 

 calculation of peak power in the designed network, 

 determination of the protection trip current for short-circuits within a time-frame defined by the user, 

 determination of continuous current-carrying capacity. 

 

Once the technical calculations are carried out and the necessary parameters are established, ArCADia-POWER 

NETWORKS informs the user about the validity of the designed network sections; namely, it verifies the correct 

choice of cables or overhead line conductors (due to the long-term current carrying capacity and voltage drop), 

correct choice of protection (retention of electric shock protection) and coordination of conductors and cables with 

protective measures. 

 

In the report the designer can see a list of potential errors in the created network. The report also informs the 

designer where and why a mistake was committed. The user can preview the partial calculations, i.e. the software 

quotes technical information (values of determined parameters) for each designed section. The report also contains 

a list of materials necessary to erect the designed network. 

The report is generated in the RTF format and contains all the information necessary for professional technical 

documentation. 

 

Technical calculations begin by defining a power source, which in our software is a transformer or connection 

point.  

At this stage, the software determines the transformer resistance and reactance. The user has two options with 

which to define the transformer: standard and non-standard. In the standard option, resistance and reactance values 

are assigned for the rated transformer power, while in the non-standard option the user inputs two parameters, i.e. 

the short-circuit voltage and power losses in winding. Resistance and reactance are calculated based on these 

values from the following formulas: 

 

- percentage short-circuit voltage uz% [%] – each transformer, depending on its power, has a percentage short-

circuit voltage 

(1) 

2

%

2

%% rzx uuu 
 – short-circuit voltage passive component 

- power losses in winding ΔPCu [W]: 
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(2) 

100% 



T

Cu
r

S

P
u

– transformer short-circuit voltage active component 

 

- transformer resistance [Ω]: 

 

(3) T

nr
T

S

Uu
R

2

%

100


 

 

- transformer reactance [Ω]: 

(4) T

nx
T

S

Uu
X

2

%

100


 

 

The designer can connect a specific number of power circuits to the transformer, i.e. the transformer rated power 

must be equal or higher than the peak power: 

 

(5) 
cos

P
SN 

 

 

where: 

cos 


 – power coefficient input by the user, 

P – maximum load power (total calculated power demand in the network). 

 

The next calculations are carried out after defining a power circuit connected to the transformer. First the software 

calculates the load current in a specific circuit.  

If the designer defines the circuit as single-phase and connects it to a defined control connector ZK-1 (the 

calculated power demand will be stated along with the cos φ power coefficient), then you should use formula (6). 

If this is a three-phase circuit, use formula (7). 

 

IL – load current present in the designed power circuit  

 

(6) 
cos3

0




N

L
U

P
I

 – three-phase load current present in a particular circuit. 

where: 

P0 – design power, 

UN – 400 [V] line-to-line voltage, 

cos φ – power coefficient input by the user, 

 

(7) 
cos

0




Nf

L
U

P
I

 – single-phase load current present in a specific circuit. 

where:  

UNf – 230 [V] phase voltage, 

 

The next step in the calculations carried out by ArCADia-POWER NETWORKS concerns voltage drops in a 

specific circuit. To this end the software uses the following formulas: 

 

Voltage drop formula for three-phase circuits: 

 

(8) 

2

0
1%

100

N

L
Us

lP
U






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Voltage drop formula for single-phase circuits: 

 

(9) 

2

0
1%

200

f

L
Us

lP
U







 
where: 

l – length of the power supply cable [m], 

s – conductor cross-section (this parameter is to be input by the designer), 

γ – conductor conductivity 

γ = 35 [m/(Ω*mm2)] for aluminium 

γ = 58 [m/(Ω*mm2)] for copper 

P – installed power [W], 

Uf – phase voltage, i.e. 230 V, 

UN – line-to-line voltage, i.e. 400 V, 

Calculating the maximum permissible voltage drop (at the network terminal), we sum up the voltage drop values 

on all sections designed by the user, i.e.: 

(10) ∆U% perm.max. = ∆UL1% + ∆UL2% + … + ∆ULn% 

In order to calculate the short-circuit currents in a particular circuit the software first calculates the resistance RL 

and reactance XL of the designed power circuit and the resulting short-circuit loop impedance ZK. To this end, the 

following formulas are used: 

(11) 
   22

KKK XRZ 
 

where: 

Rk = RTr + RL1 + RL2 + … – sum of resistances in the individual sections of the designed network, 

RTr  – transformer resistance, depending on its power, 

RL1 – each overhead line and each power cable have their resistances that depend from the conductor 

material (copper or aluminium), its cross-section and the length of the designed section. 

(12) S

l
RL



  

where:  

l – length of the power supply cable [m], 

s – conductor cross-section (this parameter is to be input by the designer), 

γ – conductor conductivity  

 γ = 35 [m/(Ω*mm2)] for aluminium 

 γ = 58 [m/(Ω*mm2)] for copper 

Xk = XTr + XL1 + XL2 + ……… – sum of reactances of the individual sections of the designed network, 

RTr  – transformer reactance, depending on its power, 

RL1 – each overhead line and each cable have their reactances that depend from the material of the 

conductor (copper or aluminium), its cross-section and length of the designed section. 

Calculations of initial, maximum and minimum short-circuit currents (single-phase short-circuit 
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current, three-phase short-circuit current, surge current) on individual sections 

of the designed network are carried out with the following formulas: 

 

- Three-phase short-circuit current: 

 

(13) K

n
fP

Z

Uc
I






3
3

 – initial current of the three-phase short-circuit, 

where: 

Zk – substitute compliant impedance of the short-circuit circuit 

 

- Single-phase short-circuit current: 

 

(14) KZ

nf

fP
Z

U
I




95,0
1

 – initial current of the single-phase short-circuit (L1-PE short), 

where: 

Unf – phase voltage in the power supply network, i.e. 230 V  

ZKZ – impedance of the short-circuit loop in case of a single-phase short-circuit (L1–PE) is equal to the total 

impedances of the transformer, phase conductors and protective conductors. 

 

Calculations of short-circuit loop impedance are carried out assuming that the cross-sections of the phase and 

protective conductors are identical (the software does not take into account any possible PE protective conductor 

cross-section shrinkage). 

 

(15) 
   22

KKKZ XRZ 
 

 

where: 

RkZ = RTr + 2*RL1 + 2*RL2 + … – sum of resistances from individual sections of the designed network, 

taking into account a PE return conductor. 

XkZ = XTr + 2*XL1 + 2*XL2 + … – sum of reactances from individual sections of the designed network, 

taking into account a PE return conductor. 

 

- Surge current: 

(16) 12 pU Ii  
 

where:
 

Ip – initial short-circuit current 

 

К – surge coefficient can be read from figure 2.2 in H. Markiewicz’s “Electric installations”. 
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3.4 DESCRIPTION OF FACILITIES 

3.4.1 Transformer station 

Once the  icon is selected, we can add an element to the project. A window with the properties of the designed 

transformer station is displayed by selecting the  button or double clicking on the inserted element. 

 

 

 

Drawing 4. Transformer station properties window 

 

First we define the visual features of the facility, i.e. we assign the transformer symbol, placement angle and 

dimensions shown in the drawing.  

 

Next we select the transformer station type. The following types are available: 

 

Polemount – mounted on special platforms installed on (usually concrete) poles. These stations are usually 

prefabricated, so there are lots of stations of the same type. Additional elements in such stations are overvoltage 

http://pl.wikipedia.org/w/index.php?title=Ograniczniki_przepi%C4%99%C4%87&action=edit&redlink=1
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limiters  that are placed between the input line and station transformer. Older station types also contained fuses 

and disconnectors. 

 

Internal – usually located inside buildings on residential, service and industrial premises, devices of this type 

differ depending on the room in which they are located. Depending on the room dimensions, elements like the 

transformer, MV distribution board, LV distribution board and distribution board bus conductors can be distributed 

differently against one another. 

 

Container – usually placed in containers or stand-alone buildings. The solutions used for container transformers 

are repetitive and in the case of urban, stand-alone units the locations of individual components may vary, 

depending on the dimensions of the rooms.  Container stations can have casings made of steel, aluminium or 

concrete. 

 

The user then defines style parameters.  

 

Transformer type: 

 

Oil-filled transformers – used as high-power transformers, these units are equipped with an oil tank where the 

transformer cooling oil is cooled. One of the disadvantages of oil is its combustibility, while others include 

the risk of fire and explosion caused by an internal short-circuit. In the event that an electric arc is formed 

there is a risk of oil vapour ignition when the duration of an internal short-circuit is long enough for large 

amounts of gas to be generated through the decomposition of oil caused by the arc. 

 

Dry transformers (air-insulated) – these are competitive for oil-filled transformers within the medium power 

range. Low fire risk allows the transformer to be placed near power take-offs. Heat emission is on the average 15% 

lower in comparison with an identical oil-filled transformer unit. Their failure ratio is definitely lower in 

comparison with oil-filled transformers. These units can withstand short overloads. 

 

The transformer power, short-circuit voltage and power losses in winding are parameters that allow 

determining the transformer resistance and reactance, which are necessary to carry out short-circuit calculations 

and to verify the criteria for selecting a transformer for the designed network. 

The values of these parameters depend on the transformer type. 

 

A “Transformer station” is the facility from which we begin designing a power network.  

If we have defined the desired transformer parameters, we may proceed to determining the location of the facility 

in the drawing (bitmap or DWG map). The facility takes the following form in the drawing: 

 

 

3.4.2 Buried line 

A buried power line is a multi-core cable, a bundle of single-core cables in a multi-phase arrangement along 

with  cable fixtures, placed along a common route and connecting terminals of the same two-electric devices, 

single- or multi-phase or single- or multi-pole. Such lines are erected both for direct current and alternating current. 

Buried lines are usually placed in the ground, but thanks to their advantages, their use was expanded into other 

applications. They can be laid in cable ducts, on walls and structures, in tubes, they can be suspended on load-

bearing strings etc. 

Buried lines are primarily used where the erection of overhead lines is burdensome and not recommended due to 

dense development and high industrialisation. This applies in particular to industrial facilities and urban areas. 

 

http://pl.wikipedia.org/w/index.php?title=Ograniczniki_przepi%C4%99%C4%87&action=edit&redlink=1
http://pl.wikipedia.org/wiki/Bezpiecznik
http://pl.wikipedia.org/wiki/Od%C5%82%C4%85cznik
http://pl.wikipedia.org/wiki/Wymiar
http://pl.wikipedia.org/wiki/Aluminium
http://pl.wikipedia.org/wiki/Beton
http://pl.wikipedia.org/wiki/Kabel_elektryczny
http://pl.wikipedia.org/wiki/Osprz%C4%99t_kablowy
http://pl.wikipedia.org/wiki/Urz%C4%85dzenie_elektryczne
http://pl.wikipedia.org/wiki/Pr%C4%85d_sta%C5%82y
http://pl.wikipedia.org/wiki/Pr%C4%85d_zmienny
http://pl.wikipedia.org/wiki/Linia_elektroenergetyczna_napowietrzna
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Once the  icon is clicked, we can add an element to the project. The buried line properties editing window 

is displayed by selecting the  button or double-clicking the inserted element. 

 

 

Drawing 5. Buried line properties window 

 

In the first buried line design stage the user selects a short-circuit and overload protection system for the line. 

ArCADia-POWER NETWORKS provides the following four options: 

Protection – protective conductor – short-circuit and overload protection devices will be placed at the beginning 

of the designed line (buried line protection) and at the end (supplied device protection). 

 

Protection – conductor – short-circuit and overload protection devices will be placed only at the beginning of the 

designed line (buried line protection). 

 

Conductor – the designed buried line without protection devices.  

Conductor – protection – short-circuit and overload protection devices will be placed only at the end of the 

designed line (buried line protection). 

 

Then the user defines visual aspects and properties of the designed line. 

DESCRIPTION OF CABLE LINE PARAMETERS: 

 

Cable route length – this is the length of a buried line section drawn by the designer (line length in the drawing). 
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Length – this is a parameter defining the total length of the designed buried line section, i.e. taking into account 

the bends and vertical sections not shown in the drawing. This value is adopted by the software for technical 

calculations. 

 

Ambient temperature [ºC] – this is the temperature of the surrounding environment when the analysed conductor, 

which is located in this environment, is not under load. 

 

 Voltage factor – a multiplier that needs to be applied to the rated network voltage in order to define the highest 

or the lowest network voltage value during a short-circuit. 

 

Network rated voltage Un  

Voltage factor c, used to calculate:  

maximum short-circuit current 

cmax
1)  

minimum short-circuit 

current cmin  

Low voltage between 100 

V and 1000 V  

1.05 2)  
0.95  

1.10 3)  

Tab 1. Voltage factor c 

1) cmax.Un cannot exceed the highest device voltage, Um 

2) For LV (within a range of +6%, e.g. for 380 or 400 V) 

3) For LV (within a +10% voltage range). 

Max. earth current cut-off time – regulations concerning the protection against electric shock (automatic 

disconnection of supply) resulting from indirect touch require that the short-circuit earth currents in networks be 

tripped by protective devices within a specific period of time. The maximum permissible tripping times in networks 

depend on the rated voltage to earth and the permissible limit voltage under the particular environmental conditions 

(50 V or 25 V). 

 

Rated voltage to earth U0 

[V] 

Voltage factor c, used to calculate:  

maximum short-circuit current 

cmax
1)  

minimum short-circuit 

current cmin  

0.4 

Low voltage 400 V 0.4 0.2 

 

Tab 2. Permissible tripping times for earth short-circuits in TN networks 

In certain circumstances (mostly in outdoor networks), longer tripping times than those provided in table 2 are 

allowed, however not longer than 5 seconds. 

 

Wire arrangement – the method of laying a cable is the parameter that influences the definition of the continuous 

current-carrying capacity of a specific cable. Due to its designated purpose (designing external power networks) 

the software provides two placement options: in the ground and overhead (open spaces). 

 

Conductor metal – suitable electricity conductors are usually aluminium or copper. Aluminium has a lower 

electric conductivity in comparison with copper (γAl = 35 
2mm

m

 , γCu = 58 
2mm

m

  ), but it is a metal 

significantly cheaper than copper.  
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Conductor insulation – insulation separates conductor cores from one another and from other earthed elements, 

protects the conductors against adverse weather conditions and prevents people from touching the elements. 

Conductor insulation is usually made of polyvinyl chloride (plasticised PVC – limit temperature 70 °C) or cross-

linked polyethylene (XLPE, limit temperature 90 °C). 

 

Network layout – ArCADia-POWER NETWORKS enables designing TN network layouts. This is a system in 

which the neutral point (zero) is earthed directly and conducting elements are connected to it by protective PE or 

by protective-neutral PEN, due to which the short-circuit loop is made entirely of metal. The software differentiates 

between two sub-systems: TN-C – with a common protective-neutral PEN conductor and TN-S – equipped with 

two separate conductors: neutral (N) and protective (PE). 

 

 

Drawing 6. Schematic diagram of sub-systems: a) TN-C, b) TN-S and c) TN-C-S: 

Number of phase conductors – the number of conductors that conduct electric current. 

Conductor cross-section – the user may use standard conductor core cross-sections. The conductor cross-section 

is an important parameter, influencing the calculations of short-circuit currents and voltage drops. 

Cable type – a power supply buried line can contain a single multi-core cable or a bundle of single-core cables. 
The cable type that we will use influences the continuous current-carrying capacity of the designed buried line. 

Protections – conductors connecting electricity consumers with the power supply source should be protected 

against the consequences of short-circuits and overloads by protective devices that trip the power supply when an 

overload or short-circuit occurs.  

The user may use a library of the most frequently employed short-circuit and overload protection measures, such 

as fuses or overcurrent circuit breakers. Protections are divided by type, kind and rated current value. Each 

protection has a short-circuit trip current value assigned for three durations: 0.2 [s], 0.4 [s], 5 [s] and a protection 

trip current value through a bimetal thermal overload release. 

In order to define the protection, click the button “terminal/initial protection”. The following window appears: 
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Drawing 7. Protection properties window 

The library of protective devices is contained in the “Type library”  

Due to the broad range of protection devices available in the market, the ArCADia-POWER NETWORKS user 

can create their own protection. The user enters the name and technical parameters of the device, such as: 

protection rated current and trip current for three durations: 0.2 [s], 0.4 [s], 5 [s] and enters the value of 

multiplicity ratio for the protection device rated current in order to obtain the trip current for the defined 

protection during long-lasting overloads. The protection created by the user will be stored in the library, which 

they will be able to use when creating new designs. In order to create your own protection, click “Add type”. 

After defining the properties of the designed buried line, the user continues to draw the buried line. Line drawing 

begins with a transformer station by clicking at the item centre or with a “connection point” and ends with a “cable 

connector” or “distribution board”. 

The drawing shows the basic features and properties of the buried line, i.e. the designed cable type, route length 

and diameter. A symbol marking the number of the designed line can be seen under the buried line. 

An example buried TN-S line made of copper conductor, with XLPE insulation, 4 mm2 core cross-section, 15.5 

mm cable diameter, one phase conductor and 5.0 m route length. 

 

3.4.3 Overhead line 

 

Once the  icon is clicked, we can add an element to the project. The overhead line properties editing window 

is displayed by selecting the  button or double-clicking the inserted element. 
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Drawing 8. Overhead line properties window 

 

Parameters of an overhead line are almost identical to those of a buried line. 

In overhead lines the conductor types come in three categories, namely: 

- bare aluminium conductor (non-insulated), 

- insulated AsXS conductor (XLPE insulation), 

- insulated AsXSn conductor (XLPE insulation, fire retardant), 

 

An additional parameter is the line sag, meaning the distance between the centre of the span between two poles 

and a straight line connecting the conductor suspension points.  

3.4.4 Cable connection 

Electric installation connection – electric device in which a connection is made between the common distribution 

electric network with the electric installation of the recipient. 

Once the  icon is clicked, we can add an element to the project. The cable connection properties editing 

window is displayed by selecting the  button or double-clicking the inserted element. 
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Drawing 9. Cable connection properties window 

 

As in all items, we begin with the definition of the visual features and the location angle in the drawing. 

Further on the user defines whether the specific connection is earthed, what the maximum permissible earthing 

resistance should be and whether it has a particular class overvoltage limiter. This information is reflected in the 

drawing: 

 

Next, we define the style parameters: connection size, rated continuous current, peak current, number of outgoing 

bays and protection degree. These parameters are strictly associated with the cable connection type. If the rated 

continuous current and peak current values are lower than the load current and short-circuit current on lines input 

to the connection respectively, the generated report will produce a message informing about selecting an incorrect 

connection. 

 

A very important cable connection parameter is the calculated power demand that we want to send, as this enables 

calculations that allow to select an appropriate buried line and overhead line. 
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Entering the rated continuous current and peak current values enables ArCADia–POWER NETWORKS to 

verify whether a specific connection type fulfils the conditions of the designed network with respect to load and 

surge resistance. 

 

Number of outgoing bays – the user declares how many circuits (buried or overhead lines) can be output from a 

specific connection. 

 

Cable connection types: 

 

- transitional: calculated power demand cannot be determined for a transitional connection, which prevents the 

software from carrying out calculations. 

 

- transitional-terminal: we define the calculated power demand, coincidence factor and cos φ coefficient. These 

values allow technical calculations to be carried out. The defined coincidence factor is used to calculate the load 

power on the designed fragments of a power network.  

 

- terminal: we define the calculated power demand, coincidence factor and cos φ coefficient. These values allow 

technical calculations to be carried out. 

 

- nodal: an additional parameter in a node connection is the short-circuit loop impedance. This parameter is used 

to carry out short-circuit calculations when the user begins designing a network with a specific connection. 

3.4.5 Connection point 

Very often, designers are supposed to expand the existing power network or to create a connection from a pole or 

a cable connector. The “Connection point” enables the user to do so. 

The connection point is a location with which we begin the expansion of an existing network by defining properties 

of the existing network that are necessary to carry out technical calculations. 

 

Once the  icon is clicked, we can add an element to the project. The connection point properties editing 

window is displayed by selecting the  button or double-clicking the inserted element. 
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Drawing 10. Connection point properties window 

In the “Parameters” tab there is a table in which we can define the properties of an existing network between the 

connection location and the transformer station, e.g.: 

 

 
 

The user inputs the line type, conductor metal, core rated cross-section and length. These parameters will enable 

short-circuit calculations (inspection of electric shock protection by using a quick supply disconnection system). 

In the “Style parameters” tab the user defines technical parameters of the transformer powering an existing 

network, to which we want to connect. 

PART DESIGNED BY THE USER EXISTING PART TO WHICH WE 
CONNECT 

SECTION 1 SECTION 2 SECTION 4 SECTION 3 

YKY 5x10 YAKYs4x35 AL50 AL70 

TRANSF
ORMER 

CONNECTION 
POINT 

ZK TR 
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After the parameters for the existing network fragment are defined, we determine the connection point location on 

the drawing, such as an existing pole or cable connection. 

3.4.6 Distribution board 

Distribution board – ArCADia-POWER NETWORKS defines the distribution board as an internal switchgear 

in the building to which the so-called internal power supply line is routed.  

 

Once the  icon is clicked, we can add an element to the project. The designed distribution board properties 

editing window is displayed by selecting the  button or double-clicking the inserted element. 

 

 

Drawing 11. Distribution board properties window 

The “distribution board” parameters are: installed power, power factor, coincidence factor. 

 

Installed power – sum of rated powers from all the consumers installed in the building. 
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Coincidence factor – defines the number of devices operating simultaneously in a particular building. The user 

selects the factor value individually for each building. 

 

Power factor – cos φ is a measure of energy consumption. The power factor defines how much power delivered 

to a specific system is converted to active power (which the system uses effectively). The user assumes the 

anticipated power factor in the power supply circuit connected to the distribution board. 

 

The style parameters for the distribution board are load properties of the board (rated continuous current, peak 

current) and the board dimensions that are reflected in the drawing: 

 
 

3.4.7 Cable joint box 

Cable joint box – this is an element of the cabling equipment for a buried power line, used to connect two cable 

sections in such a manner that their mechanical and electric resistance at the connection point is not lower than 

that of the cable. 

Once the  icon is clicked, we can add an element to the project. A window defining the properties of the cable 

joint box is displayed by selecting the  button or double clicking on the inserted element. 

 

Drawing 12. Cable joint box properties window 

The user can choose between four types of cable joint boxes: 

- branch cable joint 

- straight cable joint 

- tee cable joint 

- stop cable joint 

 

 

As in the case of all other items, we begin by defining the visual features in the drawing.  
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3.4.8 Power pole 

Power pole – ArCADia-POWER NETWORKS enables inserting power poles into the design, which are used 

to design overhead network sections and in external lighting systems. 

 

Once the  icon is clicked, we can add an element to the project. A window enabling the definition of properties 

of the designed power pole is displayed by selecting the  button or double clicking on the inserted element. 

 

Drawing 13. Power pole properties window 

By ticking the “earthing” or “limiter” box in the “Parameters” tab the user declares that the pole is earthed and 

equipped with an overvoltage limiter. The user is able to enter the permissible value of earthing resistance. This 

parameter is reflected in the drawing. 

 

Pole functions: 

 

Intermediate – used when the line route is not bent by more than 2 degrees. 

 

Corner – influenced by the resultant tension force from both pole sides. Corner angles are not large; therefore, the 

resultant force is not high. 

 

Terminal – such poles are adapted to withstand an exclusively unilateral conductor tension and are therefore 

placed at the beginning and end of a line. 
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Section – such poles are placed in straight line sections at the ends of tension sections with intermediate poles in 

the middle. 

 

Branch – such poles are placed where the line branches off. 

 

Buried depth – burying depth under the ground surface.  

 

Then the user defines “Style parameters”, i.e. the pole design type (single, double, A-pole, with support, lighting 

post), rod type and length, base and tip diameters.  

 

Pole symbols in the drawing: 

 

Pole functions: P – Intermediate; N – Corner; O – Section; K – Terminal; R – Branch 

Pole construction types: single, twin, with support, A-pole 

 

Single intermediate pole: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.4 [m] 

 

Intermediate twin pole, "a" variant: 

 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.5 [m] 

 

Intermediate twin pole, "b" variant: 

 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.5 [m] 

 

Twin corner pole: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.5 [m] 

 

Corner pole with support: 
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rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.1 [m] 

                         1.3 - 1.6 [m] for support 

 

Corner A-pole: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.2 [m] 

 

Section A-pole: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.2 [m] 

 

Twin terminal pole: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:  1.9 - 2.5 [m] 

 

Terminal pole with support: 

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:   1.9 - 2.1 [m] 

                  1.3 - 1.6 [m] for support 

 

Terminal A-pole:  

 
rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:   1.9 - 2.1 [m] 

 

Intermediate branch pole: 
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rod length: 8.2; 9.2; 10.0; 12.0 [m] 

buried depth:   1.9 - 2.1 [m] 

 

When selecting a specific pole the user should obtain a list of the materials necessary for its reinforcement.  

In order to design a lighting network the user can design lighting posts and geometric dimensions of the lighting 

installation. 

Once the user has selected a lighting post, parameter selection options for the power of the fitting, power factor, 

coincidence factor, extension arm length and the number of extension arms. 

The user can also install a lighting fitting on a power pole by ticking the “Lighting” check box. 

3.4.9 Protective pipe 

Protective pipe – ArCADia-POWER NETWORKS enables inserting protective pipes into the design, which 

are used to protect cables and conductors against weather conditions. 

 

Once the  icon is clicked, we can add an element to the project. A window defining the properties of the 

designed protective pipe is displayed by selecting the  button or double clicking on the inserted element. 
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Drawing 14. Protective pipe properties window 

 

The user defines the protective pipe diameter and its use. Next they determine its desired length in the drawing. 

The beginning and end of the protective pipe are defined in the drawing. 

 

 

3.4.10 Insert survey point  

Survey point – ArCADia-POWER NETWORKS enables the insertion of geodetic coordinates (X, Y) for any 

points in the projection.  

Once the  icon is clicked, we can add an element to the project. A window defining the properties of the survey 

point is displayed by selecting the  button or double clicking on the inserted element. 
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Drawing 15. Survey point properties window. 

 

Drawing 16. View of the survey point in the projection. 

In order to generate a report with the geodetic coordinates, the user should click . Geodetic coordinates are 

stored in an RTF file under any name. 
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3.4.11 Changing views of 2D items 

Each item in the ArCADia-POWER NETWORKS module has its own predefined 2D symbol (appearance) on the 

projection. The user may change this view into one created by themselves using the view change feature. The 

“Change item 2D appearance”  icon is available in the item properties window in the View control group. 

 

Drawing 17. “Change item 2D appearance” icon location properties window 

After clicking the icon the user gains access to the 2D appearances library. Folders and sub-folders contain the 

appearances of typical electric devices. 
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Drawing 18. 2D item appearance selection window 

The user can draw the appearance of a 2D item themselves and save it in the 2D item library using the Item 

explorer. 

Once a view is inserted using ArCADia-INTELLICAD or AutoCAD, click the  icon in order to name the newly 

created 2D item and then select an area on the projection where the item has been drawn. It will be added to the 

user’s elements folder. From there on it will be available in the element properties and can be used to change the 

2D item appearance. 

 

3.4.12 Editing and introducing types.  

To display the Type library editor dialog box, click the icon: 

 

ArCADia software: 

 The System ribbon  Type Library    

 

AutoCAD or ArCADia-INTELLICAD software: 

 ArCADia-SYSTEM toolbar    

or write 

 ISA_ETL. 

 

The Type library editor is used to edit and introduce new item types into the ArCADia software. It facilitates 

access to manufacturers catalogues and enables selecting only those catalogues which the user uses most often 

when designing. Additionally, types are divided into a Standard library (i.e. the library provided with a given 

software version) and a User library, where all the new or user modified element types are saved. 
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Drawing 19. Type library editor window 

In the upper part of the type editor window (Drawing 199) the user has the possibility to select a branch from the 

drop-down list where all the branch-modules available in ArCADia BIM are listed. 

 

 

Drawing 20. Drop-down list view of the branches available in the ArCADia BIM system 

After selecting the appropriate branch the user has access to all the items from the Elements drop-down list (on 

the right) available in the selected branch (module), e.g. buried line (Drain. 21). 
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Drawing 21. Drop-down list of the elements available in the electrical networks branch  

in the ArCADia BIM system 

After clicking on the selected element in the Global library all element types will be available. During the first 

run it will be the Standard library types (files provided with a given version of the software). During the design 

process you may add additional types into the libraries, creating a User library. 

 

 

Drawing 22. Type library editor window after selecting an appropriate branch and 

one of its elements. 

 

The lower part of the editor window is divided into the Global library (left) page and Project library (right) 

page. 
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The Global library is the place where all the default element types available for the user and the elements added 

when working with the software are added; it is divided into the Standard library (a library provided with a given 

version of the software, which the user does not change) and a User library, which contains elements (types) 

saved by the user when working with the software. 

 

Project library – where all the element types used or available for use in the project are listed. Type for the 

element can be selected from the Element properties window (Drawing. 23, Drawing 24): 

 

 

Rys. 1. Type insertion from the level of item properties 

and in the modification and insertion windows: 

 

 

Drawing 23. Type insertion point from the element modification and insertion window level 

Above the type library windows there are icons with the following functions: 

Add new type  – after clicking this icon the user has the possibility to add a new type to the Global library or 

the Project library (to the User library). It is also possible to edit type properties for the particular element, where 

the user may determine all the element’s characteristic parameters, including type parameters, view. 

 

NOTE! Clicking the Add new type icon when a type has been previously highlighted in the Library will add a new 
type based on the highlighted one. This facilitates entering a catalogue of items to the library, e.g. supplied by one 
company, where the only distinctive feature is e.g. the diameter. 

Add new folder  – after clicking this icon the user has the possibility to add a new folder, where he can then 

later add element types. A window prompting for the folder name will appear. After entering the folder name you 

need to press the  button in order to add the folder to the library or  to cancel the 

command. 

 

Drawing 24. Folder types insertion window 

Delete  – after clicking this icon the user may delete the selected type or folder. 

Type properties  – after clicking this icon the user will have access to the properties of the selected type. These 

values can be edited and saved here.  
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Leave only the types used in the project  – after clicking this icon in the Project library, only the types used 

in the project (used in any object in the project) will remain visible. 

After clicking a type with the right mouse button, a menu becomes available: 

 

 
 

Type properties – works the same as the icon described above. 

Copy – copies the type. 

Paste – pastes a previously copied type and inserts it with the same name and subsequent number. 

Rename – the user may rename an already inserted type. 

Delete – works the same as the icon described above. 

 

The  button is located above the project library. Once you click this button, the Project 

library settings will be saved in the template and will be accessible for future projects using this template. Next 

to it there is an  icon – when clicked, it provides the user with a list of available templates. 

 

 

Drawing 25. Sample properties window 

In the Project library window you can also check what types of a particular element are currently in use in the 

projection, which is displayed in the form of a  symbol on the left of the name of a particular type. 
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Drawing 26. The type library editor window after entering the type to the project library. 

The following icons are available below the two libraries: 

Hide everything . After clicking the same icon the types tree in a given library will be hidden down to the main 

catalogues. 

Extend everything  After clicking this icon, the type tree in a given library will be extended. 

 

The user may also search the library by typing a part or the entire name of the desired type in the 

 field. The button  is located next to the field. After clicking the 

button, the editing search field will be cleared.  

 

Once you select types or folders, the transfer buttons located between the libraries are activated. 

Copy all to the project library  - copies the entire global library content to the project library. 

Copy to the project library  – copies the selected elements to the project library. 

Copy to the global library  – copies the selected elements to the global library. 

Copy all to the global library  – copies the entire project library content of the selected element to the global 

library. 

 

Messages that may be displayed when working with the Type library editor: 

1. This message informs the user that a type with this name already exists. After clicking the 

, information from the new type will be saved and will overwrite the information in the previous type.  
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2. This message informs the user that the types marked by the user are going to be deleted. The 

 button confirms type deletion. 

 

 
 

3. This message informs that the layout of the project library was saved to a project 

template, e.g. Standard. 
 

 
 

NOTE! If the user has made any changes in the Project library while working with the project, modified existing 
types or expanded the library by adding new types, the new types will become available for future projects. The 
user should add the new types to the Global library using the transfer buttons. 

3.4.13 Generating a schematic diagram  

ArCADia-POWER NETWORKS enables generating structural diagrams showing the designed buried lines, 

overhead lines and individual items (transformer station, connections, overhead line poles, lighting posts, electric 

boards). The diagram presents the power supply layout for the designed network in a schematic form, starting from 

the transformer (or a connection point) up to the last object in the designed network. All the items generated in the 

diagram can be edited and their properties can be defined.  

 

Once the  icon is clicked, a view handle (system of coordinates) appears on the bar, where you can enter a 

location on the projection of the generated diagram. Once the diagram is generated, when you click an item (e.g 

Transformer station), the following window appears: 
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Drawing 27. Properties window for an item on the generated diagram 

This window will defining the colour, item description and its technical properties by clicking the Properties 

button. 

3.4.14 Generation of lists 

ArCADia-POWER NETWORKS enables generating lists of items used in the design. The software saves the 

list in RTF format, which can be opened in any version of MS Word or OpenOffice.  

Once the  icon is clicked, a “Save report/list” dialogue box appears from the bar. This box is used to select the 

location where the generated lists will be saved on the hard drive. In order to preview the saved file you need to 

locate the path and open the file by double-clicking it. 

 

 

Drawing 28. List configuration window 
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3.4.15 Example material list 

 

Material list 

Item 

no. 
Name Unit Quantity 

1. Protective pipe DVK Ф 160 mm m 7.8 

2. Distribution board 200/150/70 cm 250 A IP 44 pcs. 1 

3. Lighting post L = 10.50 m 1x150 W, extension arm 1.0 m  pcs. 7 

4. Industrial time-delay fuse: WT-00, WT-1 16 A pcs. 1 

5. Industrial time-delay fuse: WT-00, WT-1 125 A pcs. 1 

6. Overcurrent circuit breaker, C 63 A class pcs. 1 

7. Industrial time-delay fuse: WT-00, WT-1 100 A pcs. 1 

8. Industrial time-delay fuse: WT-00, WT-1 25 A pcs. 1 

9. Small-size 6A time-delay fuse pcs. 1 

10. Transitional two-pole connector: 250 A 100/150/50 cm IP 44 pcs. 1 

11. Transitional two-pole connector: 250 A 100/150/50 cm IP 44 pcs. 1 

12. Dry-type transformer 630 kVA pcs. 1 

13. Splitting element pcs. 1 

14. Multi-core buried line, YKY 5x50 mm2 m 80 

15. Multi-core buried line, YAKXS 4x10 mm2 m 74 

16. Multi-core buried line, YAKXS 4x70 mm2 m 40 

17. Multi-core buried line, YAKXS 4x35 mm2 m 45 

3.4.16 Generating network verification reports 

ArCADia-POWER NETWORKS enables generating network verification reports concerning items inserted into 

the project. The software saves the reports in RTF format, which can be opened in any version of MS Word or 

OpenOffice.  

This function is selected by clicking the  icon on the tool bar. First, the software verifies the designed circuits. 

If any irregularities are disclosed, they will be displayed in the “Network verification report” window. If at least 

one correct circuit can be found in the designed network, we can obtain a report by clicking the “RTF report” 

button. 
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Drawing 29. Network inspection report window 

The “Save report/list” dialogue box appears for correctly designed networks or when the report is to be generated 

only for correct circuits. This window is sued to select the save destination path on the HDD for the generated 

report. In order to preview the saved file you need to locate the path and open the file by double-clicking it. 

 

 

Drawing 30. Save report/list dialogue box 

The generated report contains a specification of all the circuits output from the transformer. A table shows the 

values of load currents, short-circuit currents, line resistance and reactance, voltage drops and lengths of the 

designed network sections. 

The remaining parts of the report include a verification of the correctness of cable, conductor short-circuit and 

overload protection selection, as well as verifying that electric shock protection is retained. 
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3.4.17 Exemplary network verification report 

 

Specification of lines output from TRAFO-1 transformer 

 

Section 

marking 

Length 

[m] 

Resistance 

[Ω] 

Reactance 

[Ω] 

Voltage 

drop [%] 

Load current 

[A] 

Short-circuit 

current [kA] 

Surge 

current 

[kA] 

            
Single-

phase 

Three-

phase 
  

L-1 40.0 0.018 0.003 0.37 55.87 4.12 6.55 5.96 

L-2 80.0 0.030 0.006 0.62 55.87 2.10 3.87 3.03 

L-3 45.0 0.039 0.003 0.02 1.69 2.58 4.68 3.72 

L-4 14.0 0.042 0.001 0.02 1.69 1.10 2.11 1.58 

L-5 4.0 0.012 0.000 0.00 0.48 1.14 2.21 1.64 

L-6 3.8 0.011 0.000 0.00 1.21 0.97 1.87 1.39 

L-7 8.5 0.026 0.001 0.00 0.24 0.90 1.76 1.30 

L-8 18.8 0.056 0.002 0.02 0.97 0.72 1.42 1.04 

L-9 7.6 0.023 0.001 0.01 0.73 0.63 1.24 0.90 

L-10 8.7 0.026 0.001 0.00 0.48 0.55 1.08 0.79 

L-11 8.8 0.026 0.001 0.00 0.24 0.48 0.96 0.70 
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Verification of voltage drops in circuits 

Circuit voltage drop TRAFO-1 –> TR-1 

ΔUmax = ΔUL-2 + ΔUL-1   

ΔUmax = 0.62% + 0.37% = 0.99% 

is lower than the permissible value, which is 5.00%. 

Circuit voltage drop TRAFO-1 –> S-7 

ΔUmax = ΔUL-11 + ΔUL-10 + ΔUL-9 + ΔUL-8 + ΔUL-6 + ΔUL-4 + ΔUL-3   

ΔUmax = 0.00% + 0.00% + 0.01% + 0.02% + 0.00% + 0.02% + 0.02% = 0.08% 

is lower than the permissible value, which is 5.00%. 

Circuit voltage drop TRAFO-1 –> S-3 

ΔUmax =  ΔUL-7  + ΔUL-5  + ΔUL-4  + ΔUL-3   

ΔUmax  =  0.00%  + 0.00%  + 0.02%  + 0.02%  =  0.05% 

is lower than the permissible value, which is 5.00%. 

L-1 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

138.00 A  ≥  55.87 A   

Coordination condition for conductor with protection – protection at circuit start 

Io   ≤   INprot   ≤   Idd 

55.87 A  ≤  125.00 A  ≤  138.00 A   

IZ   ≤   1.45*Idd 

200.00 A  ≤  200.10 A   

Industrial time-delay fuse: WT-00, WT-1 125 A fulfils protection the coordination conditions with the 

power supply circuit 

Single-phase short-circuit breaking capacity verification – protection at circuit start 

Σ R  =  0.005 Ω  

Σ X  =  0.014 Ω  

Zzw   =  0.015 Ω  

Ip1   ≥   IZ 

12075.00 A  ≥  713.60 A   

From the current-time protection characteristics - Industrial time-delay fuse: WT-00, WT-1 125 A – it 

can be concluded that the short-circuit breaking condition in a period shorter than required (5 s) is 

fulfilled.  

Conclusion: the designed circuit fulfils the requirements in the scope of electric shock protection 

efficiency. 

Coordination condition for conductor with protection – protection at circuit end 

Io   ≤   INprot   ≤   Idd 

55.87 A  ≤  100.00 A  ≤  138.00 A   

IZ   ≤   1.45*Idd 

160.00 A  ≤  200.10 A   

Industrial time-delay fuse: WT-00, WT-1 100 A fulfils protection the coordination conditions with the 

power supply circuit 

Single-phase short-circuit breaking capacity verification – protection at circuit end 

Σ R  =  0.040 Ω  

Σ X  =  0.020 Ω  

Zzw   =  0.045 Ω  

Ip1   ≥   IZ 

4120.34 A  ≥  579.60 A   

From the current-time protection characteristics - Industrial time-delay fuse: WT-00, WT-1 100 A – it 

can be concluded that the short-circuit breaking condition in a period shorter than required (5 s) is 

fulfilled.  
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Conclusion: the designed circuit fulfils the requirements in the scope of electric shock protection 

efficiency. 

L-2 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

167.00 A  ≥  55.87 A   

Coordination condition for conductor with protection – protection at circuit end 

Io   ≤   INprot   ≤   Idd 

55.87A  ≤  63.00 A  ≤  167.00 A   

IZ   ≤   1.45*Idd 

91.35 A  ≤  242.15 A   

Overcurrent circuit breaker, C 63 A class fulfils the coordination conditions for protection with the 

power supply circuit 

Single-phase short-circuit breaking capacity verification – protection at circuit end 

Σ R  =  0.099 Ω  

Σ X  =  0.031 Ω  

Zzw   =  0.104 Ω  

Ip1   ≥   IZ 

2102.57 A  ≥  630.00 A   

From the current-time characteristics of the protection – overcurrent circuit breaker, C 63 A class – it 

can be concluded that the condition of short-circuit breaking in a period shorter than required (5 s) is 

fulfilled.  

Conclusion: the designed circuit fulfils the requirements in the scope of electric shock protection 

efficiency. 

L-3 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

94.00 A  ≥  1.69 A   

Coordination condition for conductor with protection – protection at circuit start 

Io   ≤   INprot   ≤   Idd 

1.69 A  ≤  25.00 A  ≤  94.00 A   

IZ   ≤   1.45*Idd 

40.00 A  ≤  136.30 A   

Industrial time-delay fuse: WT-00, WT-1 25 A fulfils protection the coordination conditions with the 

power supply circuit 

Single-phase short-circuit breaking capacity verification – protection at circuit start 

Σ R  =  0.005 Ω  

Σ X  =  0.014 Ω  

Zzw   =  0.015 Ω  

Ip1   ≥   IZ 

14339.06 A  ≥  98.80 A   

From the current-time protection characteristics – Industrial time-delay fuse: WT-00, WT-1 25 A – it 

can be concluded that the short-circuit breaking condition in a period shorter than required (5 s) is 

fulfilled.  

Conclusion: the designed circuit fulfils the requirements in the scope of electric shock protection 

efficiency. 

 



ArCADia-POWER NETWORKS User Manual  

Working with the software 
 

 
49 

L-4 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  1.69 A   

Coordination condition for conductor with protection – protection at circuit start 

Io   ≤   INprot   ≤   Idd 

1.69 A  ≤  16.00 A  ≤  47.00 A   

IZ   ≤   1.45*Idd 

25.60 A  ≤  68.15 A   

Industrial time-delay fuse: WT-00, WT-1 16 A fulfils protection the coordination conditions with the 

power supply circuit 

Single-phase short-circuit breaking capacity verification – protection at circuit start 

Σ R  =  0.082 Ω  

Σ X  =  0.021 Ω  

Zzw   =  0.085 Ω  

Ip1   ≥   IZ 

2170.31 A  ≥  62.50 A   

From the current-time protection characteristics – Industrial time-delay fuse: WT-00, WT-1 16 A – it 

can be concluded that the short-circuit breaking condition in a period shorter than required (5 s) is 

fulfilled.  

Conclusion: the designed circuit fulfils the requirements in the scope of electric shock protection 

efficiency. 

L-5 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.48 A   

L-6 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  1.21 A   

L-7 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.24 A   

L-8 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.97 A   

L-9 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.73 A   
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L-10 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.48 A   

L-11 line 

Condition of continuous current-carrying capacity 

Idd   ≥   Io 

47.00 A  ≥  0.24 A  

 


